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OBJECTIVES 
The purpose of this guide is to walk you through the process of downloading rest of season projections and dropping them into your 

existing rankings and dollar value calculations so you can make informed in-season roster decisions.   

OVERVIEW 
This e-book assumes you have followed the “Create Your Own Fantasy Baseball Rankings” process or that you have worked through the 

e-book “Using Standings Gain Points to Rank and Value Fantasy Baseball Players”. 

After performing the steps in this book, your rankings file will contain updated projections for the remainder of the season, allowing you 

to evaluate trades and free agency pickups with greater precision.   The process can be performed in several minutes, once you get the 

hang of it, meaning it can be updated on a regular basis throughout the season, if you wish. 

Here is an outline of the steps required to add rest-of-season projections to your rankings spreadsheet: 

 Introduction and Starting Your New Rankings File 

 Download and Prepare Rest of Season Projections 

 Delete Old Projection Data and Paste in New Rest of Season Projections 

 Add the IFERROR Formula 

 Update the Player ID Map 

 Adjust Replacement Level 

PART 1 – INTRODUCTION AND STARTING YOUR NEW RANKINGS FILE 
INTRODUCTION 

If you're a frequent SFBB reader, hopefully you spent the offseason toiling over a spreadsheet making projections, developing 

rankings, and calculating dollar values. 

That dynamite spreadsheet you created has probably been sitting on the shelf for the last month accumulating dust.  But did you 

know you can still use it to make informed in-season roster decisions? 

http://www.smartfantasybaseball.com/create-your-own-rankings/
http://www.smartfantasybaseball.com/e-book-using-standings-gain-points-to-rank-players-and-create-dollar-values/
http://www.smartfantasybaseball.com/projecting-x-podhorzer-how-to-create-your-own-fantasy-baseball-projections/
http://www.smartfantasybaseball.com/create-your-own-rankings/
http://www.smartfantasybaseball.com/create-your-own-rankings/
http://www.smartfantasybaseball.com/e-book-using-standings-gain-points-to-rank-players-and-create-dollar-values/
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I'll show you how in a second. 

AVOID THIS SCENARIO 

Once the season starts, we immediately become retrospective in our decision making.  You navigate out to the free agent listing 

and you see the stats players have accumulated to date.  Some utility infielder with a .240 career average is sitting there staring at 

you with 5 HR and a .386 batting average to start the season. 

This is bad.  We don't draft based on last season's stats, so why should we make current roster decisions about last week's stats? 

As we do during the draft, we should be making roster decisions based on projected or future performances. 

Some sites do offer full season projections.  They are helpful, but they become less meaningful as the season progresses.  Full 

season projections are likely not being updated, and we don't care about the stats that someone has already earned. 

What we really want are rest of season projections.  Or what a player is going to do from here on out. 

HOW TO OBTAIN REST OF SEASON (ROS) PROJECTIONS 

You might recall that I use the Steamer projections that are freely available for download at Fangraphs.  Not only have Steamer 

projections proven to be one of the more accurate projection systems, there is also an easily downloadable RoS version! 

To locate the Rest of Season download, hover over the "Projections" link on the Fangraphs menu bar and look for "Steamer 

(Ros)". 

 

An "Updated" projection is also available, but this is not of much value to fantasy players.  It essentially accounts for what has 

http://steamerprojections.com/blog/about/
http://razzball.com/fantasy-baseball-projections-review-2012/
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already happened and adds in the projected future results. 

Just like the preseason download, the RoS file is downloadable in a CSV format that can be dropped into your existing rankings 

spreadsheet after performing a few simple steps. 

I TRY TO DESIGN MY SPREADSHEETS SO THEY CAN BE UPDATED EASILY 

As you worked through the rankings and dollar value creation steps I've written about, you might have noticed there are a lot of 

tabs and that the spreadsheet seems to have a lot going on.  You might have wondered why we didn’t just calculated standings 

gain points right next to the projection information.  I purposely designed it so the projections are isolated from the rest of the 

spreadsheet.  This allows for updates to more easily be copied from elsewhere (like a RoS download or an updated preseason 

projection) and pasted into your file without messing up the surrounding formulas and calculations. 

HOW ROS PROJECTIONS CAN BE USED 

In Larry Schecter’s book, “Winning Fantasy Baseball”, one of the key principles he preaches is being able to make 

objective decisions about players.  He does this at the draft and during the season using calculated dollar values.  

He outlines a process in which he manually updates projections for specific players if he is considering a trade or 

a free agency pickup.  But fortunately, we have Steamer’s regularly updated projections available to us for free. 

Having updated projections will allow you to make more objective assessments of trades and free agency 

acquisitions.  No more evaluating trades by feel, hoping a fantasy expert responds to your tweet, or looking at 

cryptic Yahoo player rankings.  You will have clear guidance.  For example, assume you’re offered a trade of a 

recently injured Bryce Harper for Ben Zobrist.  Do you make the deal?   

It’s difficult to say.  You could look up preseason dollar values.  But of course, Harper comes out on top.  How long will Harper be 

injured?  How does that affect his value?  How do you account for the fact that Zobrist qualifies at shortstop?   

If you are able to project Harper and Zobrist’s statistics for the rest of the year, the decision becomes easier.  And a formula based 

spreadsheet also allows you to add your own adjustments.  Maybe you think you can pick up a replacement player while Harper 

is on the DL that will earn you some stats.  Your spreadsheet can inform you exactly how much those replacement stats are 

worth.   

 

http://www.amazon.com/gp/product/1937110575/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=1937110575&linkCode=as2&tag=smarfantbase-20&linkId=CS2M2NAPC6Y5YJ4R
http://www.amazon.com/gp/product/1937110575/ref=as_li_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=1937110575&linkCode=as2&tag=smarfantbase-20&linkId=CS2M2NAPC6Y5YJ4R
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You Give You Get 

Bryce Harper $13.59 Ben Zobrist $14.94 
Replacement Player   $2.30   

 

Even though Harper and the effect of the replacement player have the advantage, perhaps the acquisition of Zobrist allows you to 

drop your awful shortstop and pick up an interesting OF from the waiver wire.   If you widen your frame and include the effect of 

the additional players, perhaps Zobrist earns the edge. 

Or you’re wondering how to evaluate a 3-for-3 player deal?  Or a 1-for-3 deal?  Having current dollar values for all players 

involved and the free agents you could acquire in the 1-for-3 deal, will help bring clarity to these decisions.   

DOLLAR VALUES PROVIDE THE ULTIMATE CLARITY 

You can directly compare a hitter’s total standings gain points to another hitter’s standings gain points to determine the better 

player.  But because of the 70-30 hitter-to-pitcher allocation, you can’t directly compare hitters to pitchers.  If the hitter player 

pool totals 361 standings gain points, the pitcher player pool totals 206 standings gain points, and you prefer a 65-35 hitter-to-

pitcher allocation, how much is a hitter who will earn 4.2 SGPs worth?   

I’ve written a detailed step-by-step guide that walks you through the process of converting standings gain points into dollar 

values.  The guide, “Using Standings Gain Points to Rank and Value Fantasy Baseball Players”, also calculates the effect of 

inflation in keeper leagues and even provides updated prices during the draft that incorporate the effect of in-draft inflation.  

This guide is available for $9.99.  Click here to read more about it.   

Once you have completed the process of calculating dollar values, your spreadsheet can easily be updated by following the steps 

in this manual in exactly the same fashion as if you had not added the dollar value calculations.  This manual walks you through 

the process of changing the inputs in the SGP and/or dollar value calculations, the projections.  All calculations based upon the 

projections will update automatically based upon the new underlying projections. 

STEP-BY-STEP INSTRUCTIONS 

The main point of Part 1 is to explore the concept of RoS projections and how they can be used.  There's not a lot of work 

to perform yet.  We'll just use your preseason rankings file as a starting point for the parts to come. 

http://www.smartfantasybaseball.com/2013/11/strategy-tip-widen-your-frame/
http://www.smartfantasybaseball.com/2014/02/what-is-the-ideal-spending-allocation-between-pitchers-and-hitters/
http://www.smartfantasybaseball.com/e-book-using-standings-gain-points-to-rank-players-and-create-dollar-values/
http://www.smartfantasybaseball.com/e-book-using-standings-gain-points-to-rank-players-and-create-dollar-values/
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Step Description 

1.  Locate and open the rankings file you created during the preseason.  From the “File” menu, choose the option to “Save As”. 

 
 
Unless you’re already very familiar with Microsoft Excel, I highly recommend you work through the “Create Your Own 
Rankings” series first.  But if you’re feeling adventurous and want to dive right in, you can use this file as a starting point. 

 

2.  When prompted, give the file a new name to reflect the fact that this is for the upcoming season.  You may want to put the 
year in the title in order to indicate exactly what this file is for.   

 
 

3.  Then hit Save.   

 
 

4.  That’s it?  Yeah.   

EXAMPLE EXCEL FILE 

Want to look at a real example Excel file?  The example spreadsheet illustrating the work done to this point is available here.   

 

http://www.smartfantasybaseball.com/create-your-own-rankings/
http://www.smartfantasybaseball.com/create-your-own-rankings/
http://www.smartfantasybaseball.com/wp-content/uploads/2014/05/RoS-Example-Starting-Point.xlsx
http://www.smartfantasybaseball.com/wp-content/uploads/2014/05/RoS-Rankings-and-Dollar-Values-Part-1.xlsx
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QUESTIONS? 

Do you have questions about Part 1?  Or want to see what others have asked?  Check here. 

PART 2 – DOWNLOAD AND PREPARE REST OF SEASON PROJECTIONS 
INTRODUCTION 

In the second part of the series we will download the free Rest of Season Steamer projections that are available from 

Fangraphs.com. 

STEP-BY-STEP INSTRUCTIONS 

Ste
p 

Description 

1.  Visit Fangraphs’ Steamer RoS projections at this link or visit Fangraphs.com and hover over the “Projections” link on the 
menu bar and look for “Steamer (RoS)”. 

 
 

2.  Once the page loads, use the link to “Export Data”. 

http://wp.me/p310vv-Hw
http://www.fangraphs.com/projections.aspx?pos=all&stats=bat&type=steamerr
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3.  The data will download in CSV (comma separated value) format.  Locate the downloaded CSV file and open it.  It should 
open in Microsoft Excel (if it doesn’t, launch Excel and then use the File>Open menu to open the CSV file).   
 
You might recall from our earlier work that the Fangraphs reports come with PlayerID as the last column in the file.  We 
must move this to be the first column so we can later use the VLOOKUP formula to pull data from these RoS projections.   
 
Once the file opens, locate the “playerid” column.  Right-click on the column header (column “W” in the image below) and 
choose to Cut the column. 

 
4.  Now right-click on the first column header and choose the option to “Insert Cut Cells”. 
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5.  Repeat the steps above for pitchers.  You can obtain RoS Steamer pitcher projections here or by clicking the “Pitchers” 
button at the top of the Steamer hitters web page. 

 
 
The “playerID” column is currently column “S” in the Steamer RoS download. 
 

 
6.  You have finished reordering the information and have copied it so it can be pasted into your rankings and dollar value 

calculation spreadsheet. 

 

EXAMPLE EXCEL FILE 

We did not edit the main dollar value calculation spreadsheet in this part, so no example spreadsheet is provided.   

QUESTIONS? 

Do you have questions about Part 2?  Or want to see what others have asked?  Check here. 

PART 3 – DELETE OLD INFO AND INSERT NEW ROS PROJECTIONS 
INTRODUCTION 

In this third part of the series we will remove the old (preseason) projections from our spreadsheet and paste in the new 

information. 

 

http://www.fangraphs.com/projections.aspx?pos=all&stats=pit&type=steamerr&team=0&players=0
http://wp.me/p310vv-HY
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STEP-BY-STEP INSTRUCTIONS 

Step Description 

1.  Locate the Steamer Hitters tab in your main spreadsheet.  Click once in cell A2 to select it.  Then use the 
SHIFT+CTRL+END keyboard shortcut to select all information from cell A2 to the bottom right hand corner of the 
information.  After selecting the information hit the DELETE key.   

 
2.  Return to the RoS hitters projection spreadsheet you downloaded.  Click once on cell A2 to select it.  Then use the 

SHIFT+CTRL+END keyboard shortcut to select all information from cell A2 to the bottom right hand corner of the 
information.  After selecting the information, right-click and copy it (or use the CTRL + C keyboard shortcut). 

 
3.  Now return back to the Steamer Hitters tab in your main spreadsheet once again.  Click once in cell A2 and paste the RoS 

information here.  You should notice lower stat totals for every player because these are just stats for the remainder of the 
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season. 

 
4.  If you click over to the “Hitter Ranks” tab you will see updated projections pulling through along with updated SGP totals 

and dollar values.  The dollar values may be quite odd at this point because we must revise replacement level for the new 
projections.   
 
You might also see some players that pull through into the “Hitter Ranks” tab as errors.  These likely represent players that 
won’t be playing the RoS due to injury, retirement, etc.  We’ll address these issues next. 

 
5.  Repeat the steps above using the “Pitcher Ranks” tab and the Steamer RoS projections downloaded previously. 

 

EXAMPLE EXCEL FILE 

Want to look at a real example Excel file?  The example spreadsheet illustrating the work done to this point is available here.   

 

http://www.smartfantasybaseball.com/wp-content/uploads/2014/05/RoS-Rankings-and-Dollar-Values-Part-3.xlsx
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QUESTIONS? 

Do you have questions about Part 3?  Or want to see what others have asked?  Check here. 

PART 4 – ADD THE IFERROR FORMULA 
INTRODUCTION 

In the fourth part of the series we’ll introduce a new Excel formula to help remove lookup errors, like those shown above, from 

our spreadsheets.  These occur when we have instructed Excel to do a VLOOKUP to find a player’s RoS projections and Excel is 

unable to find the player ID within the projection data.   

Often times a player will stop appearing in the RoS projections.  This might be because they've suffered a season-ending injury, 

they've retired, or they're an unsigned free agent. If that player remains in the list of hitters or pitchers rankings, no projection 

can be found for that player.  I've realized that the rankings and dollar value formulas I previously used did not handle these 

situations very well, so it's necessary to adjust these formulas slightly. 

Adding this formula to your spreadsheet is a one-time fix.  You won’t need to go through this part when you download updated 

RoS projections in the future. 

EXCEL FUNCTIONS IN PART 4 

IFERROR 

The IFFERROR function allows us to control what happens when another function being used is calculating an error.  The image 

below is a great example of this.  On our “Hitter Ranks” tab we have a series of VLOOKUP formulas that instruct excel to go find 

Kendrys Morales’ player ID (moralke01) in the “Steamer Projections” tab.  During the 2014 season Morales is likely not included 

in the RoS projections because he remains unsigned by any Major League team.   

 

http://wp.me/p310vv-I0
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The IFFERROR function will allow us to replace the error message with any value of our choice.  It essentially works by telling 

Excel, “If this other formula I’m using comes back with an error, use this instead”. 

The formula requires two inputs: 

IFERROR(value,value_if_error) 

1. Value – This represents the formula or calculation you want Excel to perform.  In our example above it will be the 

same VLOOKUP formula we already have entered. 

2. Value_if_error – This represents the value or message we want Excel to return if the first argument, “Value”, returns 

an error.  In our example above we don’t want the default “#N/A” error message that turns up if Excel cannot locate 

Kendrys Morales in the RoS projections.  Instead, we could just ask for Excel to return zeroes for his projected stats. 

STEP-BY-STEP INSTRUCTIONS 

Step Description 

1.  Perform the following steps for all columns on the “Hitter Ranks” and “Pitcher Ranks” tabs that pull from the projections 
information.  If you have followed the standard instructions this would be columns G through P on the “Hitter Ranks” and 
columns G through P on the “Pitcher Ranks” tabs. 
 
This works best if you are able to locate a player that is pulling through “#N/A” messages instead of projections.   
 
Click on one of the cells with an error message.  In the example below, I’m using cell G118. 

 
 

2.  Here is the original formula in the cell: 
 

=VLOOKUP([@IDFANGRAPHS],STEAMER_H,COLUMN(STEAMER_H[PA]),FALSE) 
 

I will now surround the VLOOKUP formula with the IFERROR formula.  This original formula will remain exactly as is.  I 
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will just put “IFERROR(“ in front of it.  And behind the existing formula I will put “,0)”.   
 

=IFERROR(VLOOKUP([@IDFANGRAPHS],STEAMER_H,COLUMN(STEAMER_H[PA]),FALSE),0
) 

 
You can see the edits I made in the larger red bolded font.  That’s all you have to do.  Excel will now perform the exact same 
calculation as before, but if a player cannot be located in the VLOOKUP, Excel will put 0 instead of #N/A. 

3.  Because we are using Excel’s table features, as soon as you change the formula once in a column, all the remaining formulas 
in the column will immediately update too. 

4.  Perform the steps above for each of the following statistics: 
 

 AB 

 H 

 HR 

 R 

 RBI 

 BB 

 SO 

 SB 

5.  Use the same strategy of surrounding the existing VLOOKUP formula with the IFERROR formula on the “Pitcher Ranks” 
tab.  Perform the steps above for each of the following pitching statistics: 
 

 W 

 GS 

 SV 

 IP 

 H 

 ER 

 HR 

 SO 

 BB 

 FIP 

 ERA (even though this is not a VLOOKUP, it is possible to get #DIV/0! Errors) 
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 WHIP (even though this is not a VLOOKUP, it is possible to get #DIV/0! Errors) 
 

EXAMPLE EXCEL FILE 

Want to look at a real example Excel file?  The example spreadsheet illustrating the work done to this point is available here. 

QUESTIONS? 

Do you have questions about Part 4?  Or want to see what others have asked?  Check here. 

PART 5 – UPDATE THE PLAYER ID MAP 
INTRODUCTION 

In this fifth part of the series we discuss updating the Player ID Map to pull new players into the rankings information.    

PLAYER ID MAP 

The SFBB Player ID Map contains the Fangraphs, MLB, Baseball-Reference, Retrosheet, CBS, NFBC, ESPN, Baseball Prospectus, 

Davenport, and Yahoo player IDs for over 1,200 players.  It’s not a comprehensive list of past players by any means, but I make a 

concerted effort to have all current MLB players and those minor league players likely to make a fantasy impact this season.   

 

To give credit where credit is due, I originally downloaded the player map from Crunchtimebaseball.com and tailored it to meet 

my needs.  CrunchTimeBaseball is run by Tim Blaker.  He continues to maintain his own map of player IDs and generally keeps 

his more up-to-date than I do.  You can obtain his version here.    

http://www.smartfantasybaseball.com/wp-content/uploads/2014/05/RoS-Rankings-and-Dollar-Values-Part-4.xlsx
http://wp.me/p310vv-I2
http://www.smartfantasybaseball.com/wp-content/uploads/2013/03/SFBB-Player-ID-Map.xlsx
http://www.crunchtimebaseball.com/
http://crunchtimebaseball.com/baseball_map.html
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WHY UPDATE THE PLAYER ID MAP? 

April inevitably brings us players that were never intended to be fantasy relevant; minor leaguers that were not anticipated to 

make the jump, role players thrust into starting jobs, and more.  As the summer rolls on, impact rookies begin to get called up 

that may not have been in the preseason Player ID Map.  When September arrives there will be more of the same. 

While it is possible to add individual players to the player ID map, it can be inefficient to add more than a handful.  Updating the 

entire list is probably easier.   

STEP-BY-STEP INSTRUCTIONS 

These instructions will take us through the process of pulling the SFBB Player ID Map into our rankings spreadsheet. 

Step Description 

1.  It is important to save your Excel file at this point.  If something goes wrong in the steps that follow, close the Excel file and 
don’t save it.  This way you can return to the file exactly as it is right now.   

2.  Download and open the most recent SFBB Player ID Map. 

NOTE:  When opening the downloaded file, you will likely be prompted to “Enable Editing”.  If you trust that the Player ID 
Map is from a reliable resource (hopefully you do!), click “Enable Editing”.   

 

3.  Ensure that both the newly downloaded Player ID Map and the Player ID Map tab in your RoS rankings file do not have any 
filters applied before proceeding.  To do this, click on the “Data” Tab, then the “Clear” button under the “Sort & Filter” 
section of the Office Ribbon. 

http://www.smartfantasybaseball.com/wp-content/uploads/2013/03/SFBB-Player-ID-Map.xlsx
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4.  Return to the newly downloaded Player ID Map. 

Click once on cell A1, then hit SHIFT + CTRL + END on your keyboard to select the entire Player ID Map.   After everything 
is selected, release those keys.   

Then hit the SHIFT key and the up arrow key on your keyboard at the same time.   

The purpose of this exercise is to select all but the last row of the Player ID Map.  If you select an entire table in Excel and 
attempt to copy it into an existing table, the original table is blown away and is replaced by the name of the new table.  This 
would destroy all the formulas currently in place looking to our original table.   

But if we trick Excel by not selecting the entire table, our original “PLAYERIDMAP” named table will remain.  I’ve added a 
fake player as the last alphabetical item in the table too, so not copying this row will not cause any problems. 

 

 

5.  Hit CTRL + C to copy the selected information. 

Now return to the Player ID Map in your RoS ranking file.   

 

Click once in cell A1, then hit CTRL + V to paste the updated Player ID Map into your rankings file. 
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6.  I will occasionally add new columns to the Player ID Map.  If new columns exist, the width of your existing PLAYERIDMAP 
table must be adjusted to include them. 

To do this, hit CTRL + END to be taken to the bottom right hand corner of the information on the PLAYERIDMAP.  You 
might see something like in the image below.  You can see that column Q is the end of the PLAYERIDMAP in Excel (where 
the blue and white shading ends), but you can also see that now the data goes into columns beyond that. 

 

To resize the table, place your mouse over the small symbol in the corner where the existing table ends.  You should see your 
mouse cursor change to the symbol below, which indicates you can resize this. 

 

Once this resize symbol appears, click and drag with your mouse to right in order to select the additional columns of 
information. 

 

You should now see that the formatting has spread to include all the data. 
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7.  To double check that you performed these steps properly, go to the “Formulas” tab and click on the “Name Manager” 
button. 

 

In the ensuing list, you should see an entry for “PLAYERIDMAP”.  If you see something like “PLAYERIDMAP1”, you might 
have a problem.  Try starting this process over.  Close the RoS rankings file WITHOUT SAVING (remember, we saved at the 
beginning of this part, so you will only have to reperform the steps in this section), and attempt to bring in the Player ID 
Map once more. 

 

8.  This is an important step but the applicability of it depends on when you started following the site.  Information was added 
to Player ID Map over time that can cause the minor issue displayed below.  This step may be inapplicable to most people.  
If it does not apply to you, please move on to step 9.   

To determine if this step is applicable to you, open the “Hitter Ranks” tab in your RoS rankings spreadsheet.  Look at the 
columns to ensure the proper information is pulling into the proper column.  For example, you might see something like 
this: 
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You may recall that columns B-F are pulling information from the Player ID Map.  Notice that the LNAME column is 
actually pulling in the first name, FNAME is pulling in a weird number (it’s actually a numerical representation of the 
player’s birthdate), and TEAM, POS, and IDFANGRAPHS are all incorrect. 

Some small edits to the VLOOKUP formulas in these columns will fix the problem.  Note the edits below in bold red font: 

LNAME formula should be:   

=VLOOKUP([@PLAYERID],PLAYERIDMAP,COLUMN(PLAYERIDMAP[LASTNAME]),FALSE) 

FNAME formula should be: 

=VLOOKUP([@PLAYERID],PLAYERIDMAP,COLUMN(PLAYERIDMAP[FIRSTNAME]),FALSE) 

TEAM formula should be: 

=VLOOKUP([@PLAYERID],PLAYERIDMAP,COLUMN(PLAYERIDMAP[TEAM]),FALSE) 

POS formula should be: 

=VLOOKUP([@PLAYERID],PLAYERIDMAP,COLUMN(PLAYERIDMAP[POS]),FALSE) 

IDFANGRAPHS formula should be:  

=VLOOKUP([@PLAYERID],PLAYERIDMAP,COLUMN(PLAYERIDMAP[IDFANGRAPHS]),FALSE) 

Repeat this step for pitchers.  The formulas above will be the same for the “Pitcher Ranks” tab of your 
spreadsheet. 

Helpful Tip:  As you are editing these column names within the formula, you may see Excel provide you with a list of 
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column names to choose from.  Simply double click on the desired column and hit Enter. 

 

 

9.  You now have an updated the Player ID Map which should contain the players that have become fantasy relevant since the 
preseason.  However, these players are not yet added to the “Hitter Ranks” or “Pitcher Ranks” tabs.   

To do this for hitters, return to the Player ID Map tab in our RoS rankings file.   

Click on the drop down arrow on the “POS” column.  You’ll be presented with a list of all the positions.  Uncheck any “P” 
values.  Click OK to apply. 
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TIP:  If you play in an NL or AL only league, this becomes a very important step.  In addition to unchecking any “P” in the 
“POS” column, you will also want to uncheck the league you don’t use in the “LG” column.  For example, if you’re in an NL-
only league, you would uncheck the “AL” option. 
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10.  The Player ID Map will now list only hitters.  Starting at the first player and ending with the last, click and drag within the 
“IDPLAYER” column (first column) and select all player (or select the first player and then use the keyboard shortcut 
SHIFT + CTRL + ).  Only select from this first column. 
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11.  Copy this selected data.   Return to the “Hitter Ranks” sheet.  Click once into cell A2 then paste the data (there is no need to 
delete anything before doing this, just paste right over the existing player list). 

 

This will put players back into alphabetical order.  Sort them again by TTLSGP or $VALUE using the column header drop 
down menu. 
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12.  We must now add the updated pitchers from the Player ID Map to the “Pitcher Ranks” tabs.   

To do this for pitchers, return to the Player ID Map tab in our RoS rankings file.   

Click on the drop down arrow on the “POS” column.  You’ll be presented with a list of all the positions.  Toggle the “Select 
All” button until all values become unchecked.  Then check the “P” value.  Click OK to apply. 
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13.  The Player ID Map will now list only pitchers.  Starting at the first pitcher and ending with the last, click and drag within the 
“IDPLAYER” column (first column) and select all players (or select the first player and then use the keyboard shortcut 
SHIFT + CTRL + ).  Only select from this first column. 
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14.  Copy this selected data.   Return to the “Pitcher Ranks” sheet.  Click once into cell A2 then paste the data (there is no need 
to delete anything before doing this, just paste right over the existing player list). 

 

This will put players back into alphabetical order.  Sort them again by TTLSGP or $VALUE using the column header drop 
down menu. 

 

15.  You now have an Excel file with an updated Player ID map, updated Hitter & Pitcher ranks listings, and updated RoS 
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projections.  The last step in the process is to reconsider replacement level.  This is a very important step in creating 
updated dollar values.  Failure to determine replacement level accurately can lead to misleading results. 

EXAMPLE EXCEL FILE   

Want to look at a real example Excel file?  The example spreadsheet illustrating the work done to this point is available here. 

QUESTIONS? 

Do you have questions about Part 5?  Or want to see what others have asked?  Check here. 

PART 6 – ADJUST REPLACEMENT LEVEL 
INTRODUCTION 

In this sixth part of the series we will revisit the concept of replacement level and adjust replacement level for our updated RoS 

projections.   

REMINDERS ABOUT REPLACEMENT LEVEL 

If you’re new to the concept of replacement level read the introduction here (don’t go into the “Step-by-Step Instructions”.  When 

you consider the injuries that occur in Major League Baseball, rookies being called up, players underperforming projections, and 

others exceeding projections, the player pool is constantly changing.   

In order to make the best possible decisions and to calculate representative dollar values, it is very important that we update the 

estimate of replacement level.   

CAUTION:  NO FURTHER ADJUSTMENTS NECESSARY 

When listening or reading fantasy advice, you might come across a piece of advice that goes something like this, “You really need 

to draft a SS early to account for the lack of depth at the position.  Go ahead and reach for that shortstop.”   

Don’t listen to that advice when you’re using the approach we’re now going through.  The replacement level adjustment that 

follows is already calculating the effect of depth at each position.  And it does it mathematically.  There is no guesswork going on 

http://www.smartfantasybaseball.com/2013/12/a-warning-about-calculating-replacement-level/
http://www.smartfantasybaseball.com/wp-content/uploads/2014/05/RoS-Rankings-and-Dollar-Values-Part-5.xlsx
http://wp.me/p310vv-I4
http://www.smartfantasybaseball.com/2013/03/create-your-own-fantasy-baseball-rankings-part-6-accounting-for-replacement-level-and-position-scarcity/
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here.  DON’T MAKE ANOTHER ADJUSTMENT.  You do not need to make an arbitrary adjustment to shortstops or catchers, or 

any other position.  When you have added this adjustment to your rankings, each player will be ranked according the their value 

over the worst players at the position.  If the position is weak, that’s accounted for.  If the position is deep, it’s accounted for.  If 

you then decide to make arbitrary adjustments to your rankings after adding in the replacement level calculation, YOU ARE 

DOUBLE COUNTING.  You will be reaching for players and you will be hurting your team.  Don’t “bump” players up a list 

because of their position. 

STEP-BY-STEP INSTRUCTIONS 

Step Description 

1.  Locate the “Replacement Level” tab in your spreadsheet.  Select the replacement level data for the various categories (leave 
the “TOTAL” column) and hit the Delete key. 

 

Do the same for pitchers. 
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2.  Return to the “Hitter Ranks” tab.  Use the drop down arrow on the “TTLSGP” column to ensure it is sorted in descending 
order (largest to smallest). 

 

3.  Click on the downward pointing arrow on the “POS” column.  Clear all the position check boxes and select only “C”.  Click 
“OK” to accept this filter. 
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4.  Use your league settings to develop an approximation of how many catchers will likely be drafted.  For 
example, in a 12-team league in which each team starts two catchers, there likely won’t be any catchers 
starting at the DH/UTIL spot.  This means that 24 catchers will be drafted and the 25th catcher represents 
replacement level.   

I believe that identifying one specific player as “replacement level” can be misleading and that it is best to 
develop a “composite” of the replacement level player.  For example, what if the 25th catcher happens to steal 
a lot of bases and all his value comes from this stat.  It would be misleading to compare all the other catchers 
to this player.  

To calculate this approximate replacement player I suggest creating an average of five players.  The average 
will be of the last draftable player and the two players above him and the two players below him.  Sticking 
with our example that 24 catchers will be drafted, I will use catchers #22, #23, #24, #25, and #26. 

Any easy way to figure out who these catchers are is to choose a specific column, click on the value for the 
first player in the column, and then click and drag to select more players (you can see an image of this to the 
right, make sure you are highlighting only one column). 

As you continue to select more players, watch the “Count:” field on the Excel status bar.   
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5.  In looking at the 22nd – 26th best catchers, I see a rough average of 1.39 SGPs in R, 0.87 in HR, 1.41 in RBI, 0.13 in SB, and 
-0.35 in AVG. 

 

Note that if you select the RSGP information for catchers #22-#26 as shown above, Excel will display the average on the 
status bar in the lower right hand corner of the program. 

 

6.  Enter these averages into the Catcher row on the “Replacement Level” tab. 

 

7.  Repeat steps 3 – 6 for each position.   

If your league starts Corner Infielders and Middle Infielders, you can likely assume that will break down into an even split 
between 1B & 3B and 2B & SS.  For example, in a 12-team league with a CI position, a total of 36 1B or 3B will be drafted (12 
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1B, 12 3B, and 12 CI).  I usually assume this will break down to18 1B and 18 3B.  This won’t be exact, but splitting hairs 
about this will not result in much of a benefit to your rankings.   

You must perform a similar adjustment for the DH/UTIL spot in your league.  Again, assuming a 12-team league, we must 
now adjust replacement level by 12 more players.  I generally assume this will result in 6 more OF being drafted and 6 more 
1B, because 1B and OF are generally the most productive positions.  This means that I assume 24 1B will be drafted (12 to 
play 1B, 6 to play CI, and 6 to play DH/UTIL) and 66 OF (60 to play OF (5 * 12-teams), 6 to play DH/UTIL). 

It is important to keep in mind that these numbers are highly dependent upon two things that will cause the numbers I 
present below to differ from what you will see as you work with your own spreadsheet: 

 The underlying projections used 

 Your league settings 

The projections you use will surely be different from those I used to create this guide.  For one, I created this guide using the 
2013 Steamer projections.  You will be using some projection set you obtained after 2013.  The projections you use 
determine the statistics of the replacement level player.  So your replacement level player will not be the same as mine. 

Further, your league settings may be different.  I am assuming a 12-team league starting 2 catchers.  If you have a 10-team 
league or if your league starts only one catcher, your definition of who the replacement level player is will be different.   

TIP:  Because you might be updating the RoS projections several times during the season, you can take a shortcut and only 
determine the total SGP of the replacement level player, instead of calculating it category by category.  I like to see this 
information in the preseason, but as the season goes along, speed in updating the spreadsheet becomes more important.   

You can see that I’ve just typed the total SGP of the replacement level player for each position (except Catcher).  I type it in 
the average column so I don’t destroy the TOTAL column formula already in place.   
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8.  Perform steps 2-6 in order to update the pitchers replacement level table on the Replacement Level tab.   

9.  It’s possible that some players would rise or fall in the total SGP ranking after these changes.  Sort the hitter and pitcher 
ranks from highest value to lowest value again using the drop down arrow over the “TTLSGP” column. 

 

10.  It is extremely important to perform a reasonableness check when you’re done with this exercise.  If you have done 
everything correctly, when you’re done, you should see that the number of players with positive SGPs should be 
approximately equal to the number of players your league will draft.   

For example, I have been assuming a 12-team league where each team drafts 14 hitters.  This means 168 hitters will be 
drafted.  If I look in my “Hitter Ranks” tab, I should see that the players right around the #168 mark will have very close to 
0.00 for TTLSGP. 
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Row #169 represents the 168th player (accounting for the header row in the sheet).  And you can see everyone here is about 
at 0.00 SGP 

If you find that you have too many players above 0.00 TTLSGP, you must raise your replacement levels.  If the replacement 
level averages are higher, fewer players will come out above 0.00.   

If you have too few players above 0.00 TTLSGP, you must lower your replacement levels.  If replacement levels are lower, 
more players will come out above 0.00. 

11.  You did it!   

 

WRAP UP 

You have just completed the process of adding an objective ranking to a set of fantasy baseball projections.   

EXAMPLE EXCEL FILE 

Want to look at a real example Excel file?  The example spreadsheet illustrating the work done to this point is available here. 

QUESTIONS? 

Do you have questions about Part 6?  Or want to see what others have asked?  Check here. 

http://www.smartfantasybaseball.com/wp-content/uploads/2014/05/RoS-Rankings-and-Dollar-Values-Part-6.xlsx
http://wp.me/p310vv-I6
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IF YOU HAVE CALCULATED DOLLAR VALUES 
If you have calculated dollar via the “Using Standings Gain Points to Rank and 

Value Fantasy Baseball Players” guide, use the $VALUE column (not $ACTUAL 

and not $INFLATE) for your decision making.  In fact, once the season begins, you 

can delete the $ACTUAL information because it becomes irrelevant after the draft.   

If after working through this guide, you’re interested in purchasing the 

instructions on calculating dollar values, the step-by-step e-book is available here. 

 

FINAL THOUGHTS 
After you work through this process one time, your subsequent attempts will be much faster.  First, adding the IFERROR formula 

is a one-time process.  You won’t need to add this each subsequent time you download new RoS projections.  Second, updating 

the Player ID Map likely does not need to be done each time.  The player pool does not turn over that frequently.   

Essentially you only need to download new RoS information, paste it into your file, and update the replacement level 

information.   

You can probably get to a point where you can perform these steps in a matter of minutes. 

Here’s to a season full of smart and informed decisions! 

http://www.smartfantasybaseball.com/e-book-using-standings-gain-points-to-rank-players-and-create-dollar-values/
http://www.smartfantasybaseball.com/e-book-using-standings-gain-points-to-rank-players-and-create-dollar-values/

